
    
    



    
            
                
                    
                        
                            
                                
                                    
                                    44_45_46_47_Banan_PL.pdf

                                    (2012 KB)
                                    
                                        Pobierz
                                

                                
                                    
                                    
                                        








	
		
			
				
					
						WARSZTATY
					
				

			

			
				
					
						poziom trudności:
					
				

			

			
				
					
						ü
					
				

			

			
				
					
						60 Min
					
				

			

			
				
					
						o autorze
					
				

			

			
				
					
						Zuzanna Patocka
					
				

				
					
						Młoda freelancerka. Realizuje swoją pasję, tworząc eks-
					
				

				
					
						presyjne, pełne optymizmu projekty. Niektóre z nich 
					
				

				
					
						były już wykorzystywane komercyjnie. 
					
				

				
					
						Oprócz graiki poświęca się muzyce, jest perkusistką 
					
				

				
					
						i wokalistką. Wolny czas spędza w galeriach, kinie i na rowerze.
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						prosty przepis na plakat
					
				

			

			
				
					
						z bananem
					
				

			

			
				
					
						na plakat 
					
					
						z bananem
					
				

			

			
				
					
						Dzisiaj przyrządzimy smakowitą plakatową sałatkę. Można ją serwować zarówno na koncertach rockowych, 
					
				

				
					
						grungeowych, lub innych młodzieżowych happeningach. Głównym składnikiem będzie banan. Dlaczego? Bo 
					
				

				
					
						banany są zdrowe! A po za tym, dobrze wpływają na humor i samopoczucie. Dorzucimy również garść informacji, 
					
				

				
					
						żeby była bardziej konkretna, a także szczyptę przypraw w tle ożywiających smak.
					
				

				
					
						Przygotujcie narzędzia, otwórzcie Photoshopa i zabieramy się do krojenia!
					
				

			

			
				
					
						obieramy banana
					
				

				
					
						Plakat zaczniemy od przygotowania głównego składnika – banana. 
					
				

				
					
						Za pomocą narzędzia 
						Pióro
						 (
						Pen
						) obierzemy go dokładnie nakłada-
					
				

				
					
						jąc ścieżkę. Z wciśniętym klawiszem [
						Ctrl
						] zamienimy ją w selekcję, któ-
					
				

				
					
						rą następnie odwrócimy [
						Ctrl
						]+[
						I
						]i usuniemy odpadki naciskając kla-
					
				

				
					
						wisz [
						Delete
						].Tak przygotowany banan jest gotowy do wrzucenia na de-
					
				

				
					
						skę kuchenną.
					
				

			

			
				
					
						metkowanie
					
				

				
					
						Wybieramy narzędzie 
						Prostokąt zaokrąglony
						 (
						Rounder Rectangle 
					
				

				
					
						Tool
						) [
						U
						] o 
						promieniu
						 (
						Radius
						) 50px i rysujemy prostokąt w kolorze 
					
				

				
					
						białym. Następnie 
						Style warstwy>Obrys
						 (
						Layer Style>Stroke
						), któremu 
					
				

				
					
						nadajemy wartość 24 px. Niestety metka była z importu i lekko się przy-
					
				

				
					
						brudziła, dlatego zakładamy na nią maskę warstwy 
						Warstwa>Dodaj ma-
					
				

				
					
						skę warstwy>Odkryj wszystko
						 (
						Layer>Add Layer Mask>Reveal All
						) i wy-
					
				

				
					
						cieramy lekko przy brzegach czarnym pędzlem. Przechylamy lewą stronę 
					
				

				
					
						w dół używając [
						Ctrl
						]+[
						T
						].
					
				

			

			
				
					
						szczypta przypraw
					
				

				
					
						Otwieramy nowy dokument [
						Ctrl
						]+[
						N
						], A4, 300dpi, Białe Tło (nasza 
					
				

				
					
						deska kuchenna) i wrzucamy banana. Układamy go używając 
					
				

				
					
						[
						Ctrl
						]+[
						T
						]. Poprawimy jego smak  wybierając z efektów przywarstwo-
					
				

				
					
						wych 
						Barwa/Nasycenie
						 (
						Hue/Saturation
						). Aby barwa stała się bardziej 
					
				

				
					
						intensywna przesuwamy wskaźnik 
						Nasycenia
						 (
						Saturation
						) na ok. 18. 
					
				

			

			
				
					
						garść informacji
					
				

				
					
						Teraz dorzucimy trochę tekstu, ale nie za dużo, żeby sałatka nie zro-
					
				

				
					
						biła się mdła. Zaczniemy od daty. Wybieramy narzędzie tekstu [
						T
						] 
					
				

				
					
						i wpisujemy cyferki. Następnie z wciśniętym klawiszem [
						Ctrl
						] ustawiamy 
					
				

				
					
						w przestrzeni odpowiednio obracając i przesuwając. Podobnie postępuje-
					
				

				
					
						my w przypadku następnych warstw tekstowych godziny i ceny wejścia. 
					
				

				
					
						Otwieramy plik 
						mkm.psd
						 i przenosimy jego zawartość. Zakładamy 
						maskę 
					
				

				
					
						warstwy
						 i czarnym pędzlem lekko przecieramy.
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						prosty przepis 
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						WARSZTATY
					
				

			

			
				
					
						0
						5
					
				

			

			
				
					
						tło
					
				

				
					
						Potrzebujemy więcej przypraw, które podkreślą smak banana! Naj-
					
				

				
					
						pierw na nowej warstwie namalujemy czarnym pędzlem tło za bana-
					
				

				
					
						nem. Polecam jakieś grungeowe, poprzecierane pędzle, którymi pokryje-
					
				

				
					
						my prawą część plakatu i dół. Na nowej warstwie dodamy nieco subtel-
					
				

				
					
						niejsze pociągnięcia. Proponuję zmniejszyć krycie pędzla (ok. 20%, wg. 
					
				

				
					
						upodobań). Na trzeciej, ostatniej warstwie tła namalujemy łączenie met-
					
				

				
					
						ki z bananem. Sałatka nabiera ostrości.
					
				

			

			
				
					
						to nie jest zwykły banan
					
				

				
					
						Otwieramy plik punkt
						 .psd
						 i układamy go mniej więcej na środku ba-
					
				

				
					
						nana. Z efektów przywarstwowych wybieramy 
						Faza i płaskorzeźba
						 
					
				

				
					
						(
						Bevel and Emboss
						) i ustawiamy parametry: 
						Styl
						 (
						Style
						): 
						Faza wewnętrz-
					
				

				
					
						na
						 (
						Inner Bevel
						); 
						Technika
						 (
						Tachnique
						): 
						Wygładzanie
						 (
						Smooth
						); 
						Głębia 
					
				

				
					
						(
						Depth
						): 81%; 
						Kierunek
						 (
						Direction
						): 
						Do góry
						 (
						Up
						);
						 Wielkość
						 (
						Size
						): 10px ; 
					
				

				
					
						Zmiękczanie
						 (
						Soften
						): 0 px. Następnie narzędziem 
						Piórko
						 (
						Pen
						) obramo-
					
				

				
					
						wujemy logo używając tylko prostych, niezaokrąblonych linii. Dodajemy 
					
				

				
					
						obrys: 
						Styl warstwy>Obrys
						 (
						Layer Style>Stroke
						): 24 px.
					
				

			

			
				
					
						0
						6
					
				

			

			
				
					
						obtaczamy banana w świetle
					
				

				
					
						Wybieramy 
						Filtry>Rendering>Efekty świetlne
						 (
						Filter>Render>Lig-
					
				

				
					
						thening Effects
						). Ustawiamy światło z lewego górnego rogu i wpisuje-
					
				

				
					
						my następujące parametry: 
						Styl 
						(
						Style
						): 
						Własne
						 (
						Default
						); 
						Rodzaj światła 
					
				

				
					
						(
						Light Type
						): 
						Punktowe
						 (
						Spotlight
						); 
						Natężenie
						 (
						Intensity
						): ok. 28; 
						Skupie-
					
				

				
					
						nie
						 (
						Focus
						): ok. 45; 
						Odblask
						 (
						Gloss
						): -100; 
						Materiał 
						(
						Material
						): 100; 
						Świa-
					
				

				
					
						tło
						 (
						Exposure
						): ok. 10; 
						Otoczenie
						 (
						Ambience
						): ok. 21.
					
				

			

			
				
					
						logo – rozdzielanie na warstwy
					
				

				
					
						Wybieramy warstwę MKM i z podręcznego menu wybieramy 
						Utwórz 
					
				

				
					
						warstwy
						 (
						Create Layers
						). W tym momencie 
						Obrys
						 (
						Outer Stroke lay-
					
				

				
					
						er
						) stał się osobną warstwą. Dokonujemy jego selekcji, klikając z wciśnię-
					
				

				
					
						tym klawiszem [
						Ctrl
						]. Zaznaczenie zamieniamy na 
						Ścieżkę
						, przechodząc 
					
				

				
					
						do palety
						 Ścieżki
						 (
						Paths
						) i wybieramy na dole przycisk 
						Utwórz ścież-
					
				

				
					
						kę roboczą z zaznaczenia
						 (
						Make Work Path From Selection
						). Aby otrzy-
					
				

				
					
						mać wektorowy kształt, z menu wybieramy 
						Warstwa>Nowa warstwa 
					
				

				
					
						wypełnienia>Kolor kryjący
						 (
						Layer>New Fill Layer>Solid Colour
						). Wybie-
					
				

				
					
						ramy czerń.
					
				

			

			
				
					
						0
						7
					
				

			

			
				
					
						wrzucamy do piekarnika na 180º
					
				

				
					
						Filtr>Artystyczny> Wycinanka
						 (
						Filter>Artistic>Cutout
						) i ustawia-
					
				

				
					
						my następujące parametry: 
						Liczba poziomów
						 (
						Numer of Levels
						): 8; 
					
				

				
					
						Uproszczenie ścieżki
						 (
						Edge Simplicity
						): 8; 
						Dokładność krawędzi
						 (
						Edge Fideli-
					
				

				
					
						ty
						): 1. Teraz do piekarnika, uważajmy, żeby się nie poparzyć. Niezawod-
					
				

				
					
						ny sposób na zarumienioną skórkę to 
						Styl Warstwy>Obrys
						 (
						Layer Style>
					
				

				
					
						Stroke
						): na grubość 3px. Gotowe!
					
				

			

			
				
					
						logo – ciąg dalszy
					
				

				
					
						Za pomocą narzędzia
						 Pióro 
						(
						Pen
						), gdzieniegdzie dodamy i odejmie-
					
				

				
					
						my punkty krzywej lub po prostu modyfikujemy klikając na nie z wci-
					
				

				
					
						śniętym klawiszem [
						Alt
						]. Punkty możemy przesuwać z wciśniętym kla-
					
				

				
					
						wiszem [
						Ctrl
						]. Powinniśmy w ten sposób otrzymać kanciasty nieregular-
					
				

				
					
						ny obrys. Nałóżmy na niego jeszcze maskę i lekko poprzecierajmy czar-
					
				

				
					
						nym pędzlem. Teraz możemy się pozbyć na zawsze starej warstwy 
						Outer 
					
				

				
					
						Stroke
						.  
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						prosty przepis na plakat
					
				

			

			
				
					
						z bananem
					
				

			

			
				
					
						Prenumerata PRO
					
				

				
					
						specjalna oferta dla irm prenumerujących magazyn .psd
					
				

				
					
						www.psdmag.org
					
				

			

			
				
					
						banan nad miastem!
					
				

				
					
						Otwieramy kolejno pliki: 
						palac_kultury.psd
						 i 
						miasto.psd.
						 Oba wekto-
					
				

				
					
						rowe kształty wrzucamy do naszej sałatki. Pałac Kultury umieszcza-
					
				

				
					
						my na dole pod metką, a miasto po jego prawej stronie. Dopasowujemy 
					
				

				
					
						wielkość [
						Ctrl
						]+[
						T
						] i powielamy [
						Ctrl
						]+[
						J
						]. Wybierając ponownie [
						Ctrl
						]
					
				

				
					
						+[
						T
						] klikamy prawym klawiszem myszy i z podręcznego menu wybiera-
					
				

				
					
						my 
						Odbij poziomo
						 (
						Flip Horizontaly
						) i przesuwamy na lewą stronę. Zmie-
					
				

				
					
						niamy kolor wszystkich trzech obiektów na #181818.
					
				

			

			
				
					
						Bunker Studio
					
				

				
					
						Świadczymy kompleksowe usługi w In-
					
				

				
					
						ternecie; serwisy irmowe (CMS), sklepy 
					
				

				
					
						internetowe, aplikacje b2b, hosting, do-
					
				

				
					
						meny, pozycjonowanie stron i kampanie 
					
				

				
					
						reklamowe w Internecie. Realizujemy 
					
				

				
					
						również zlecenia fotograiczne, projek-
					
				

				
					
						tujemy logotypy oraz świadczymy usługi 
					
				

				
					
						poligraiczne –  projekty graiczne, skład 
					
				

				
					
						DTP, druk. 
					
				

			

			
				
					
						www.bunker.pl
					
				

			

			
				
					
						redF5
					
				

				
					
						Nieszablonowe strony www.
					
				

				
					
						Naszą dewizą jest poprawność kodu 
					
				

				
					
						wykonywanych serwisów www umożli-
					
				

				
					
						wiająca prawidłowe wyświetlanie strony 
					
				

				
					
						www niezależnie od przeglądarki. Gwa-
					
				

				
					
						rancja zgodności z normami W3C.
					
				

				
					
						Wykonujemy: serwisy www, systemy 
					
				

				
					
						portalowe, sklepy internetowe. Oferuje-
					
				

				
					
						my również gotowe, tanie strony z wy-
					
				

				
					
						konaniem. 
					
				

			

			
				
					
						zespoły
					
				

				
					
						Tekst będziemy umieszczać na ścieżkach, dlatego najpierw wybiera-
					
				

				
					
						my narzędzie 
						Pióro
						 (
						Pen
						) i stawiamy dwa punkty, wyciągając jeden 
					
				

				
					
						z wąsów w dół, tworząc łuk. Teraz wybieramy narzędzie tekstu (
						T
						), najeż-
					
				

				
					
						dżamy nim na ścieżkę i piszemy słowo 
						zagrają
						. Możemy poprawić ułoże-
					
				

				
					
						nie wciskając [
						Ctrl
						], a także edytować ścieżkę, używając 
						Pióra
						. Wpisuje-
					
				

				
					
						my dowolne zespoły, postępując analogicznie. 
					
				

			

			
				
					
						www.redF5.com
					
				

			

			
				
					
						To już koniec naszego kucharzenia w Photoshopie. Wydawałoby się, że 
					
				

				
					
						ten program służy głównie do obróbki zdjęć, a jednak cały czas nas za-
					
				

				
					
						skakuje. Nie wiem, jak dla Was, ale dla mnie przyrządzanie potraw w ten 
					
				

				
					
						sposób jest o wiele łatwiejsze niż w rzeczywistości.
					
				

			

			
				
					
						Pliki potrzebne do wykonania ćwiczenia znajdują się na 
					
				

				
					
						www.psdmag.org
					
				

			

			
				
					
						PJWSTK
					
				

				
					
						Polsko-Japońska Wyższa Szkoła Tech-
					
				

				
					
						nik Komputerowych to jedna z najlep-
					
				

				
					
						szych uczelni w Polsce. Oferuje studia 
					
				

				
					
						na kierunkach Informatyka,Sztuka No-
					
				

				
					
						wych Mediów i Zarządzanie Informa-
					
				

				
					
						cją. Prowadzi studia dzienne, wieczo-
					
				

				
					
						rowe, zaoczne, internetowe oraz studia 
					
				

				
					
						podyplomowe i kursy informatyczne. 
					
				

				
					
						Siedziby w Warszawie i Bytomiu.
					
				

			

			
				
					
						http://www.pjwstk.edu.pl
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